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Introduction
This manual describes the printer functions of the d-Copia 16W/20W digital multifunctional system.

Trademark Acknowledgments
● Microsoft® Windows® operating system is a trademark or copyright of Microsoft Corporation in the U.S.A. and other countries.
● Windows® 95, Windows® 98, Windows® Me, Windows NT® 4.0, Windows® 2000, and Windows® XP are trademarks or copyrights 
of Microsoft Corporation in the U.S.A. and other countries.

● Acrobat® Reader Copyright© 1987- 2002 Adobe Systems Incorporated. All rights reserved. Adobe, the Adobe logo, Acrobat, and 
the Acrobat logo are trademarks of Adobe Systems Incorporated.

● All other trademarks and copyrights are the property of their respective owners.

● For information on the following topics, please refer to the Operation Manual for the digital multifunctional system.
•Basic machine procedures (adding paper, replacing the toner cartridge, using peripheral devices)
•Copier functions
•Resolving printer problems
•Specifications

● Where "d-Copia xxW" appears in this manual, please substitute the name of your model for "xx". For the name of your model, see 
"DIFFERENCES BETWEEN MODELS" in the Operation Manual.

● The screen images and procedures that appear in this manual are mainly for Windows XP. With other versions of Windows, some 
screen images may be different from those in this manual.

● For information on using your operating system, refer to your operating system's manual or online Help.

The display screens, messages, and key names shown in the manual may differ from those on the actual machine due to product 
improvements and modifications.

Note
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How to Use the Online Manual
This section explains how to view the online manual. Please read this section before using the online manual.
For information on using Acrobat Reader, see Acrobat Reader Help.

How to Control the Online Manual
In this manual, the following buttons are displayed at the bottom 
of each page. Click these buttons to move quickly to pages that 
you wish to view.

Displays the Contents of this manual. Click on a topic in the 
Contents to jump directly to that section.

Displays the Index of this manual. Click on a topic in the Index 
to jump directly to that section.

Takes you forward page by page.

Takes you back page by page.

Following Links
This manual uses a link function that allows you to jump to a 
related page. If you click green, underlined text, the related 
page will be displayed. (In the Contents and Index sections, the 
linked areas are not underlined.)
Example: ☞ Contents
To return to the previous page, click the  button on the menu 
bar of Acrobat Reader.

Using Bookmarks
Bookmarks have been created on the left side of this manual. 
You can click on a bookmark to jump directly to that section.

How to Print Out This Manual
To print this manual, select "Print" from the "File" menu of 
Acrobat Reader. Select the desired printer settings in the "Print" 
dialog box, and then click the "OK" button.

CONTENTS

I N D E X
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Basic Printing (part 1)
The following example explains how to print a document from WordPad.
Before printing, make sure that the correct size of paper for your document has been loaded in the machine.

1 Make sure that the ON LINE indicator on the 
operation panel is lit.
If the ON LINE indicator is not lit, press the [ON LINE] 
key ( ).

When the indicator is:
● Lit, the machine is online and 
ready to print, or is printing.

● Blinking, the machine is 
processing print data in memory 
or printing has been paused.

● Off, the machine is off-line 
and cannot print.

2 Start WordPad and open the document that you 
wish to print.

3 Select "Print" from the application's "File" 
menu.
The "Print" dialog box will appear.

4 Make sure that "OLIVETTI d-Copia xxW" is 
selected as the printer. If you need to change any 
print settings, click the "Preferences" button 
("Properties" button in Windows 95/98/Me/NT 4.0) 
to open the printer driver setup screen.
The printer driver setup screen will appear.

Windows 2000 does not have the "Preferences" button 
in this dialog box. Select settings as needed on each of 
the tabs in the setup screen.
☞ Printer Driver Settings, Printing Multiple Pages on One Page, 

Fitting the Printed Image to the Paper,
Rotating the Print Image 180 Degrees, Printing a Watermark

5 Click the "Print" button ("OK" button in 
Windows 95/98/Me/NT 4.0).
Printing begins. When printing begins, the Print Status 
Window automatically opens.
☞ Outline of the Print Status Window
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Basic Printing (part 2)
If the tray runs out of paper during printing
Add paper to the tray or press the [TRAY SELECT] key ( ) to 
select a different tray, and then press the [ON LINE] key ( ) to 
resume printing.
Note that if "Auto tray switching" (in the user programs) is 
enabled on a 2-tray model and "Auto Select" is selected in 
"Paper Source" in the printer driver, the machine will 
automatically switch to the other tray and continue printing.

Pausing a print job
To pause a print job during printing, press the [ON LINE] key 
( ) on the operation panel to switch the machine off-line. 
Printing will be paused and the ON LINE indicator will blink.
● To cancel a print job, press the [CLEAR] key ( ) or the 

[CLEAR ALL] key ( ).
● To resume printing, press the [ON LINE] key ( ) to switch the 

machine online.

When "Paper Source" is set to "Auto Select"
If "Paper Source" is set to "Auto Select" in the "Paper" tab of the 
printer driver setup screen and the correct size of paper for a 
print job is not loaded in the machine, the printing procedure will 
vary depending on the "Use Close Paper Size" setting in the user 
programs (see "USER PROGRAMS" in the Operation Manual).

When "Use close paper size" is disabled
The PAPER SIZE indicator on the 
operation panel will blink. Press the 
[TRAY SELECT] key ( ) to manually 
select the tray and then press the [ON 
LINE] key ( ). Printing will begin. If you 
are selecting the bypass tray, load paper 
in the bypass tray.
* The paper sizes that appear in the operation panel will vary by 

country and region.

When "Use close paper size" is enabled
Printing will take place using a size of paper that is close to the 
size of the print image.

Before printing make sure that the paper size set in "Set 
Tray Status" of the printer driver is the same as the size 
of paper loaded in the tray. (See "CONFIGURING THE 
PRINTER DRIVER" in the Software Setup Guide.) When 
printing, if you select the paper tray with the correct size 
of paper for the document to be printed, printing will take 
place correctly (select the paper tray in "Paper source" in 
the "Paper" tab of the printer driver setup screen).

A3
A4
A4
A5
B4

EXTRA

Note
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Opening the Printer Driver From the "Start" Button
You can open the printer driver and change the printer driver settings from the Windows "start" button. Settings adjusted in this way 
will be the initial settings when you print from an application. (If you change the settings from the printer driver setup screen at the 
time of printing, the settings will revert to the initial settings when you quit the application.)

Windows 2000/XP

1 Click the "start" button, and then click "Control 
Panel".
In Windows 2000, click the "Start" button and select "Settings".

2 Click "Printers and Other Hardware", and then 
click "Printers and Faxes".
In Windows 2000, click "Printers".

3 Click the "OLIVETTI d-Copia xxW" printer driver 
icon and select "Properties" from the "File" menu.

4 Click the "Printing Preferences" button in the 
"General" tab.
The printer driver setup screen will appear.
☞ Printer Driver Settings

Windows 95/98/Me/NT 4.0

1 Click the "Start" button, select "Settings" and 
then click "Printers".

2 Click the "OLIVETTI d-Copia xxW" printer driver 
icon and select "Properties" from the "File" 
menu.

3 In Windows 95/98/Me, click the "Setup" tab.

The printer driver setup screen will appear.
☞ Printer Driver Settings

In Windows NT 4.0, select "Document Defaults" to open 
the printer driver setup screen.

Note
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Printer Driver Settings
To view Help for a setting, click the  button in the upper right-hand corner of the window and then click the setting.
Some restrictions exist on the combinations of settings that can be selected in the printer driver setup screen. When a restriction is 
in effect, an information icon ( ) will appear next to the setting. Click the icon to view an explanation of the restriction.

Tab
The settings are grouped 
on tabs. Click on a tab to 
bring it to the front.
Checkbox
Click on a checkbox to 
activate or deactivate a 
function.
Print setting image
This shows the effect of the 
selected print settings.
Drop-down list
Allows you to make a 
selection from a list of 
choices.
Image of paper trays
The tray selected in "Paper 
Selection" in the "Paper" 
tab appears in blue. You 
can also click on a tray to 
select it.

"OK" button
Click this button to save 
your settings and exit the 
dialog box.
"Cancel" button
Click this button to exit the 
dialog box without making 
any changes to the settings.
"Apply" button
Click to save your settings 
without closing the dialog box.

"Help" button
Click this button to display 
the help file for the printer 
driver.

1

3

2

4

5

6
7
8

9

The settings and the image of the machine will vary 
depending on the model.Note

1

2

3

4

5

Windows NT 4.0 
does not have the 
"Apply" button.
The "Apply" button 
does not appear 
when you open this 
window from an 
application.

6

7

8

Note

9
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Printing Multiple Pages on One Page
This feature allows you to reduce and print two or four document pages on a single sheet of paper.
To use this function, open the printer driver setup screen and select "2-Up" or "4-Up" for "N-Up Printing" on the "Main" tab.
☞ See Basic Printing for details on how to open the printer driver.

If you select the "Border" checkbox, borderlines will be printed around each page.

The "N-Up Printing" setting is not available when "Fit To Paper Size" is selected.
☞ Fitting the Printed Image to the Paper

N-Up Border Border

"2-Up"

"4-Up"

Note
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Fitting the Printed Image to the Paper
The printer driver can adjust the size of the printed image to match the size of the paper loaded in the machine.
Follow the steps shown below to use this function. The explanation below assumes that you intend to print an A3 size document on 
A4 size paper.
☞ See Basic Printing for details on how to open the printer driver.

1 Click the "Paper" tab in the printer driver setup 
screen.

2 Select the original size (A3) of the print image in 
"Paper Size".

3 Check the "Fit To Page" box.

4 Select the actual size of paper to be used for 
printing (A4).
The size of the printed image will be automatically 
adjusted to match the paper loaded in the machine.

The "Fit To Paper Size" setting is not available when "N-Up Printing" is selected.
☞ Printing Multiple Pages on One Page

Note

Paper Size: A3
Fit To Paper Size: A4

A3 size document
(Paper Size)

A4 size paper 
(Fit To Paper Size)
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Rotating the Print Image 180 Degrees
The print image can be rotated 180 degrees.
This feature is used to enable correct printing on envelopes and other paper with flaps that can 
only be loaded in one orientation.
To use the feature, select the image orientation in "Image Orientation" on the "Paper" tab, and 
then select the "Rotate 180 degrees" checkbox. 
☞ See Basic Printing for details on how to open the printer driver.

The following example shows correct and incorrect rotation of an address printed on an envelope.

Printing result

Landscape
Rotate 180 degrees

Landscape
Rotate 180 degrees

The procedure for loading paper is explained in the Operation Manual.

ABCD

ABCD

Note
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Printing a Watermark
You can print a watermark such as "CONFIDENTIAL" on your document. To print a watermark, open the printer driver, click the 
"Watermarks" tab, and follow the steps below.
☞ See Basic Printing for details on how to open the printer driver.

How to Print a Watermark
From the "Watermark" drop-down list, select the watermark that you wish to print (for example "CONFIDENTIAL"), and start printing.

You can enter text to create your own custom watermark. For details on watermark settings, view printer driver Help.
☞ Printer Driver Settings

Print sample
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Outline of the Print Status Window
When printing begins, the Print Status Window automatically opens.
The Print Status Window is a utility that monitors the machine and shows the name of the document being printed and any error 
messages that occur.

Status window
Provides information on the 
current status of the printer.
Status icon
The status icons appear to 
alert you to printer errors. 
Nothing appears when 
printing is taking place 
normally.
The icons are explained 
below. Follow the 
instructions in the status 
window to solve the 
problem.

Tab
Click a tab to bring it to the 
front. The "Options" tab 
allows you to select display 
options for the Print Status 
Window.
Document Name
Shows the name of the 
document currently being 
printed.
"Cancel Job" button
Printing can be canceled by 
clicking this button before 
the machine receives the 
job.
"Help" button
Click this button to display 
the help file for the Print 
Status Window.
"Close" button
Click this button to close 
the Print Status Window.

1

2

3

4

5

6

7

Icon Print Status
An error has 
occurred that 
requires immediate 
attention.

An error has 
occurred that 
requires attention 
soon.

1

2

3

4

5

6

7
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Sharing the Printer Using Windows Networking
The machine can be used as a shared printer in a Windows 95/98/Me/NT 4.0/2000/XP network environment.
Note that the Windows network environment must already be established.

"Print server" as explained here is a computer that is directly connected to the machine, and a "Client" is any other computer that is 
connected to the same network.

Shared printer
Client

Client Client

Print server

☞ Shared Printer Settings
(On the print server) ☞ Client Settings
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Shared Printer Settings
On the computer to which the machine is directly connected
Follow the steps below to use the computer directly connected to the machine as a print server.
If your operating system is Windows 95/98/Me, start from step 1. If your operating system is Windows NT 4.0, 2000 or XP Home 
Edition, open the control panel and then start from step 6.

1 Click the "Start" button, select "Settings", and 
then click "Control Panel".

2 Double-click the "Network" icon ( ).

3 Click the "File and Print Sharing" button.

4 Enable "I want to be able to allow others to print 
to my printer(s)." by clicking the checkbox, and 
then click the "OK" button.

5 Click the "OK" button in the "Network" dialog 
box.

6 Click "Printers and Other Hardware" in the 
control panel, and click "Printers and Faxes".
In operating systems other than Windows XP, 
double-click the printer icon.

7 Click the "OLIVETTI d-Copia xxW" printer driver 
icon and select "Sharing" from the "File" menu.

8 Establish the settings for sharing, and click the 
"OK" button.

☞ Client Settings

If your operating system is Windows XP Professional, refer to the Operation Manual or the help file of your operating system.Note

If the "Network" icon does not appear in Windows Me, 
click "view all Control Panel options".

Note

If a message appears asking you to restart the 
computer, click the "Yes" button and restart the 
computer. Then, open the printer folder and continue the 
setup procedures from Step 6.

For information on a setting, click the  button at the 
top-right of the dialog box and then click the setting to 
display Help.

Note

Note
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Client Settings (part 1)
Follow the procedure below to install the printer driver in the client.

1 Click the "start" button, and click "Control 
Panel".

2 Click "Printers and Other Hardware", and click 
"Printers and Faxes".

3 Click "Add a printer" in "Printer Tasks".
The "Add Printer Wizard" will appear.

4 Click the "Next" button.

This page provides steps for Windows XP Home Edition users only. If your operating system is Windows 95/98/Me/2000/XP 
Professional, refer to the Operation Manual or the help file of your operating system.
If your operating system is Windows NT 4.0, refer to "Settings in Windows NT 4.0".

Note
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Client Settings (part 2)

5 Select "A network printer, or a printer attached 
to another computer", and click the "Next" 
button.

6 Select "Browse for a printer", and click the 
"Next" button.

7 Select the printer to be shared in the network, 
and click the "Next" button.

The contents of this window will vary depending on your 
network environment.

8 Select settings in the "Default Printer" screen, 
and click the "Next" button.

9 Click the "Finish" button.
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Client Settings (part 3)
Settings in Windows NT 4.0
If your operating system is Windows NT 4.0, establish settings as follows in the printer properties after installing the printer driver.
For the procedure for installing the printer driver, see "INSTALLING THE PRINTER DRIVER" in the Software Setup Guide.

1 Click the "Start" button, select "Settings", and 
then click "Printers".

2 Click the "OLIVETTI d-Copia xxW" printer driver 
icon and select "Properties" from the "File" menu.
The printer properties will appear.

3 Click the "Ports" tab, and click the "Add Port"
button.
The "Printer Ports" dialog box will appear.

4 Select "Local Port" in the "Available Printer 
Ports" list, and click the "New Port" button.
The "Port Name" dialog box will appear.

5 Enter "\\(name of server connected to 
machine)\(name of shared printer)", and click 
the "OK" button.

6 Click the "Close" button in the "Printer Ports" 
dialog box.

7 Click the "OK" button in the printer properties 
window.

name of server connected to machine

name of shared printer
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For detailed information on the settings in the printer driver and Print Status Window, see the help files for each.
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